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Pour votre sécurité Lisez attentivement ce manuel afin d'utiliser cet appareil 
correctement et d'éviter tout danger ou dommage matériel.
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Utilisation de l'appareil

Une mauvaise utilisation peut être à l'origine d'une
explosion, d’un incendie ou d’une décharge électrique. Pour éviter les troubles auditifs

Ne prenez pas l'initiative 
de démonter, réparer ou 
modifier cet appareil 
vous-même.

Ne mouillez pas l'appareil
et ne le laissez pas tomber
dans l'eau.
Si l'appareil est mouillé, ne 
l'allumez pas. Contactez un 
centre de dépannage.

Ne posez pas l'appareil
dans un endroit humide,
poussiéreux ou couvert de
suie, sous peine de 
provoquer un incendie ou
une décharge électrique.

L'utilisation prolongée de l'écouteur ou du casque
peut fortement réduire votre acuité auditive.
Si vous vous exposez à un volume sonore
supérieur à 85 dB pendant une durée prolongée,
votre ouïe sera irrémédiablement endommagée.
Plus le son est élevé, plus votre acuité auditive
diminue (une conversation ordinaire a un niveau
sonore compris entre 50 et 60 dB alors que celui
provenant d’une route est d'environ 80 dB).
Il est fortement recommandé d'utiliser un volume
sonore moyen (le volume moyen est habituellement
inférieur de 2/3 au volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus 
l'écouteur ou le casque.

Pour éviter tout risque d'accident de la route

N'utilisez pas l'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.
Dans le cas contraire, vous risqueriez de provoquer un
accident grave. En outre, son utilisation est interdite par la
loi dans certaines régions. L'utilisation de l'écouteur dans
la rue, particulièrement sur les passages pour piétons, 
pourrait entraîner des accidents graves.
Pour votre propre sécurité, assurez-vous que le câble de
l'écouteur n’entrave pas vos mouvements ou ne s’ac-
croche pas dans des objets environnants lorsque vous
faites de l'exercice ou lorsque vous vous promenez.

Ne laissez pas l'appareil
dans un lieu où la 
température excède 35°C 
(ex.: sauna ou voiture en 
stationnement).
En été, la température à 
l'intérieur d'une voiture peut 
atteindre 80°C.

Vous risquez de vous blesser gravement si vous ne tenez pas compte de
ces instructions.AVERTISSEMENT
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Utilisation de l'appareil

Gestion des données importantes Evitez de causer des dysfonctionnements

Veillez à toujours 
enregistrer vos données les
plus importantes
Notez bien que nous ne saurons
être tenus responsables en cas de
perte des données due à une
panne, à une réparation ou à toute
autre cause.

Evitez de causer des dysfonctionnements

Suivez attentivement ces instructions sous peine de provoquer des blessures physiques
ou d'endommager l'appareil. ATTENTION

Evitez tout impact brutal 
sur l'appareil (ex. : en 
cas de chute). Ne posez pas
d'objets lourds sur le
dessus de l'appareil.

Empêchez que des 
particules externes ou de
la poussière ne pénètrent
dans l'appareil.

Utilisez toujours les 
accessoires fournis ou
agréés par Samsung.

Evitez toute projection d’eau
sur l'appareil. Ne nettoyez
jamais l'appareil à l'aide de 
produits chimiques 
(ex. : benzène ou diluant) sous
peine de provoquer un
incendie, une décharge 
électrique ou une détérioration
de la surface.

Ne posez jamais l'appareil à
proximité d'objets émettant des
ondes électromagnétiques sous
peine de provoquer un 
dysfonctionnement.
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Fonctions du produit

Compact et mince
Durée de lecture plus longue et durée
de téléchargement plus courte !

■   Conçu pour avoir une apparence compacte
et mince.

■   Une batterie complètement chargée peut
vous procurer jusqu’à 25 heures de
musique (avec les écouteurs).

■   Le lecteur peut accueillir la fonction USB
2.0, bien plus rapide que la fonction USB
1.1, pour permettre une communication
plus rapide avec votre ordinateur.

Clavier tactile Peut accueillir différents 
formats de fichiers !

■   Tapez sur le clavier pour naviguer dans les
menus.

■   Peut accueillir différents formats de
fichiers, incluant les MP3, WMA et Ogg.

■   Vous pouvez afficher des fichiers aux 
formats JPG et TXT sur le lecteur.

Arborescence de menus 
simple et conviviale Avantage

■   Convivial avec son arborescence de menu
simple.

■   Vou pouvez profiter d’une grande variété
de fonctions incluant la radio FM, le
visionnement de photos, etc.
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Vue de face, côté droit

Interrupteur
Alimentation
et Maintien

Affichage à l’écran

Bouton de retour 
en arrière

Bouton Lecture/Pause 
et Sélectionner

Bouton Menu

Bouton 

Tous les boutons sont de type ‘à effleurement’.

Composants
Renseignements fondamentaux
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Dessous/arrière

Port USB

Prise
Ecouteurs

Trou de 
réinitialisation

Composants (suite)
Renseignements fondamentaux

[arrière]
[Dessous]

Vérification des accessoires

Lecteur Ecouteurs Câble USB CD d'installation

■ L’aspect des accessoires est susceptible d'être amélioré et modifié, sans notification préalable.
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Affichage des informations à l'écran
Renseignements fondamentaux

REMARQUE

■   Les représentations à l’écran figurent à titre indicatif uniquement. L'écran réel de votre appareil peut
être différent.

Music (Musique)

1 Affichage du mode Play (Lecture)

2 Egaliseur graphique

3 Renseignements sur la musique

4 Barre d’état Play (Lecture)

5 Affichage du numéro de la piste en
cours/du nombre total de pistes

6 Affichage de l'effet sonore

7 Affichage de l’état de la batterie

8 Témoin de durée de lecture

9 Affichage de l’état Lecture/Pause

Normal

1.Life is cool

002/020 √√ 00:02:20

1

2

3

4
5

6 

7

8

9
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Fonctions des boutons
Renseignements fondamentaux

■   Faites glisser dans le sens opposé à celui indiqué par la flèche pour
allumer/éteindre l'appareil.

■   Faites glisser dans le sens indiqué par la flèche pour verrouiller les boutons.

■   Appuyez longuement sur le bouton pour accéder à l'écran de menu.
■   Appuyez brièvement sur le bouton pour revenir à l'écran précédent.

Boutons Fonctions et utilisation

■   Appuyez pour afficher le menu des options.

■   Déplacement vers le haut, le bas, la gauche et la droite et sélection des
fonctions

Appuyez pour vous déplacer d’une sélection vers le haut ou vers le bas.

Appuyez pour vous déplacer d’une sélection vers la droite ou vers le
gauche.

Appuyez longuement pour vous déplacer continuellement vers le
haut ou vers le bas.

Appuyez brièvement pour sélectionner lecture/pause et la 
fonction de déplacement sur l’écran suivant.

■   Recherchez une piste et contrôlez le volume tout en écoutant la musique.
Appuyez longuement sur le bouton pour balayer vers un point de la
piste en cours.

Appuyez brièvement pour revenir à la piste précédente ou lire la
piste en cours à partir du début.

Appuyez longuement sur le bouton pour balayer vers un point de la
piste en cours.

Appuyez légèrement dessus pour aller à la plage suivante.

Appuyez sur le bouton pour diminuer/augmenter le volume.
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ATTENTION

■   N'utilisez pas d'objet tranchant pour actionner le pavé tactile.
Vous risqueriez de l'endommager.

■   Veillez à garder les mains propres lorsque vous souhaitez utiliser le pavé tactile.

■   Ne gardez pas vos gants lorsque vous appuyez légèrement sur l'écran tactile. Le bouton risquerait de ne
pas fonctionner.

✽ Tapez légèrement avec
votre doigt.

Branchement des écouteurs

√ Dessous

Ecouteurs
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Chargement de la batterie Chargez la batterie complètement avant d'utiliser le
lecteur pour la première fois ou lorsqu'il n'a pas été
utilisé depuis longtemps.

Renseignements fondamentaux

1 Branchez le câble USB sur le port
USB (      )de votre ordinateur.

2 Branchez l'autre extrémité du câble
USB sur le fiche USB situé dans la
partie inférieure du lecteur.
■ Une fois le lecteur branché à l'aide du câble

USB, le temps nécessaire à un chargement
complet est d'environ quatre heures ; ce
temps est susceptible de varier en fonction de
l'environnement installé sur l'ordinateur.

Utilisation de la batterie

■   Rechargez et rangez l'appareil dans un lieu où la
température est comprise entre 5°C et 35°C.

■   Evitez de surcharger la batterie (12 heures au
maximum). Charger ou décharger la batterie à
des fréquences trop rapprochées peut réduire sa
durée de vie.

■   Comme pour tout autre produit de consommation,
la durée de vie de la batterie raccourcit 
progressivement avec le temps.

■   Vérifiez si la pile de l’ordinateur bloc-notes est complètement chargée et utilisez le câble USB
pour charger le produit. Si la charge de la pile du bloc-notes n’est pas suffisante, n’utilisez pas le
câble USB pour la charger.

REMARQUE
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Utilisation de base
Renseignements fondamentaux

Mise sous et hors tension de l'appareil

Mise sous tension de l'appareil
Appuyez longuement sur l’interrupteur [ HOLD √] dans la 
direction opposée à la flèche.
■ L'appareil s'allume.
‘

Mise hors tension de l'appareil
Appuyez de nouveau longuement sur l’interrupteur [ HOLD √]
dans la direction opposée à la flèche.
■ L'appareil s'éteint.

■   L’appareil s'éteint automatiquement lorsque aucun des boutons n'est actionné pendant une
durée prédéfinie (par défaut : 1 minute) en mode Pause (Pause). √ Page 46REMARQUE

REMARQUE

■   Appuyez brièvement sur le bouton [ ] pour revenir à l'écran précédent.

■   Appuyez longuement sur le bouton [ ] pour vous déplacer vers le menu principal.

Lire des fichiers musicaux

1 Appuyez longuement sur le bouton [ ] pour vous 
déplacer vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner <Music>

(Musique), puis appuyez sur le bouton [ ].
■ Le menu Music (Musique) apparaît.

3 Utilisez les boutons [ ] et [ ] pour sélectionner un fichier
musical de votre choix.

4 Appuyez sur le bouton [ ].
■ La lecture du fichier musical est lancé.

Normal

1.Life is cool

002/020                                                  √√  00:02:20

Normal

1.Life is cool

002/020                                                  √√  00:02:20
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Réglage du volume

Fonction Lock (Verrouillage)

Appuyez sur le bouton [ ].
■   L’icône du contrôle de volume s’affiche.

■   Appuyez sur le bouton [ ] pour augmenter le volume ou sur le bouton [ ]
pour le diminuer.

En mode Hold, tous les boutons sont désactivés. Vous apprécierez
particulièrement le côté pratique de cette fonction lors de vos
marches ou de vos courses à pied.

1 Poussez l’interrupteur [ HOLD √] dans le sens de la flèche.

2 Poussez l'interrupteur [ HOLD √] dans le sens opposé à celui
indiqué par la flèche pour désactiver la fonction Lock
(Verrouillage).

Utilisation de base (suite)
Renseignements fondamentaux

Normal

1.Life is cool

002/020                                                  √√ 00:02:20

Normal

1.Life is cool

002/020            √√ 00:02:20
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Si un dysfonctionnement de l'appareil
survient, vous pouvez réinitialiser le système
en appuyant sur le Trou de réinitialisation.

Appuyez sur le Trou de réinitialisation
situé sur la partie inférieure de l'appareil
à l'aide d'un objet pointu, comme une
agrafe.
■  Le système est réinitialisé.

■  La fonction Reset (Réinitialisation) ne permet
pas de supprimer les renseignements de
durée et les données enregistrées dans la
mémoire intégrée.

Fonction Reset (Réinitialisation)

Trou de
réinitialisation
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Installation de Media Studio de Samsung
Utilisez Media Studio pour
transférer des fichiers 
musicaux de votre ordinateur
vers le lecteur.

Chargement de votre fichier favori

Avant de démarrer! Insérez le CD d'installation fourni avec le lecteur dans le lecteur de CD-ROM
de votre ordinateur.

Si Media Studio ne s'installe pas automatiquement
■   Installez le programme sur un ordinateur fonctionnant sous Windows 2000 ou Windows XP après

vous être connecté en tant qu’administrateur. Veuillez vous reporter au manuel d’utilisation de 
l’ordinateur pour savoir comment vous connecter en tant qu’administrateur.

ATTENTION

1 Cliquez sur <Install now> (Installer maintenant).

2 Cliquez sur <NEXT> (SUIVANT).
■ L’installation de Media Studio est lancée.

■ Une fois l'installation terminée, un icône
apparaît sur le bureau et Media Studio démarre.
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Branchement de l'appareil sur un ordinateur
Chargement de votre fichier favori

Avant de démarrer! Utilisez le câble USB fourni pour brancher l'appareil sur l'ordinateur.

1

1

Branchez le câble USB sur le port USB (     ) de votre ordinateur.

2

2

Branchez l'autre extrémité du câble USB sur le fiche USB situé dans la partie
inférieure du lecteur.

Votre système d’ordinateur doit satisfaire les caractéristiques suivantes :

■   Pentium 300 MHz ou plus ■   Windows 2000/XP
■   DirectX 9.0 ou version ultérieure ■   Port USB 2.0
■   100 Mo d'espace libre sur le disque dur ■   Lecteur de CD-Rom (2X ou plus)
■   Résolution 1024 X 768 ou plus ■   Windows Media Player 9.0 ou version ultérieure
■   Internet Explorer 6.0 ou version ultérieure

Configuration requise

ATTENTION

■   Si vous branchez le lecteur via un concentrateur USB, la connexion risque d’être instable. 
Veuillez brancher le lecteur directement sur l'ordinateur.

■   Si vous branchez le lecteur sur l'ordinateur alors que la batterie est trop faible, le lecteur vérifie
automatiquement l'état de la batterie et se recharge durant plusieurs minutes avant de se con-
necter à l'ordinateur.
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Ajout de fichiers/dossiers dans Media Studio de Samsung
Chargement de votre fichier favori

Veuillez vous reporter à la section Aide pour obtenir plus d'informations sur 
l'utilisation de Media Studio.
■ Cliquez sur <MENU> (MENU) ➝ <Help> (Aide) ➝ <Help> (Aide) dans le menu situé en haut du 

programme Media Studio ou appuyez sur le bouton  F1 de votre clavier durant la lecture

Media Studio vous permet de sélectionner et de répartir vos fichiers et dossiers en
prévision du transfert vers votre lecteur.

33

2
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1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur
votre ordinateur.
■ Si le programme ne démarre pas automatiquement, double-cliquez sur l'icône Media Studio

située sur le bureau.

2 Cliquez sur l'icône associée au fichier de votre choix située à gauche.

■
Choisissez le type de fichier que vous souhaitez transférer en cliquant sur l’un de ces icônes.

représente un fichier musical et représente une photo.

■ Cliquez sur l’icône pour afficher la liste ETC. La liste ETC comprend d’autres types de fichiers
(ex. : texte, xov, etc) que les fichiers musicaux, photo et vidéo.

3 Cliquez sur <Add Folder> (Ajouter un fichier) au bas
de l’écran de Media Studio.
■ La fenêtre Open Folder (Fichier ouvert) apparaît.

Avant de démarrer! ■ Branchez le lecteur sur l'ordinateur.
■ Media Studio doit être installé sur l'ordinateur.

Pour ajouter des fichiers

3 Cliquez sur <Add File> (Ajouter un fichier) au
bas de l’écran de Media Studio.
■ La fenêtre Open (Ouvert) apparaît.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).
■ Les fichiers sélectionnés sont ajoutés à la liste située à gauche

dans l'écran Media Studio (Media Studio).

Pour ajouter des dossiers

4 Sélectionnez les dossiers que vous souhaitez
ajouter et cliquez sur <OK> (OK).
■ Les fichiers du dossier sélectionné sont ajoutés à la liste située

à gauche dans l'écran Media Studio (Media Studio).

4

4
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Transfert de fichiers vers le lecteur avec Media Studio de Samsung
Chargement de votre fichier favori

Exécutez les étapes suivantes pour transférer les fichiers depuis votre ordinateur
vers le lecteur.

REMARQUE

■   La technologie de reconnaissance musicale et les données relatives sont fournies par
Gracenote et Gracenote CDDB® Music Recognition ServiceSM. 

■   CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo
et le logotype Gracenote CDDB et le logo “Powered by Gracenote CDDB” sont des 
marques déposées de Gracenote. Music Recognition Service et MRS sont des marques de
service de Gracenote.

4

3

2

Fenêtre
Portable
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1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
■ Si le programme ne démarre pas automatiquement, double-cliquez sur l'icône Media Studio

située sur le bureau.

2 Cliquez sur l'icône associée au fichier de votre choix située à gauche.

■ Choisissez le type de fichier que vous souhaitez transférer en cliquant sur l’un de ces icônes.
représente un fichier musical et représente une photo.

■ Cliquez sur l’icône pour afficher la liste ETC. La liste ETC comprend d’autres types de fichiers
(ex. : texte, xov, etc) que les fichiers musicaux, photo et vidéo.

3 Sélectionnez le fichier à transférer sur la liste de gauche.

■   Ne débranchez pas la fiche USB durant le transfert sous peine d'endommager le lecteur ou
l'ordinateur.ATTENTION

■   Lors du transfert d'un fichier photo vers le lecteur à l'aide de <Media Studio> (Media Studio), le
fichier est converti automatiquement au format JPG avant le transfert. La taille du fichier est
également réglée automatiquement.

■   Un fichier photo transféré vers le lecteur sans <Media Studio> (Media Studio) peut être différent
de la source lors de son affichage sur l'écran du lecteur.

REMARQUE

4 Cliquez sur l’icône .

■ Les fichiers sélectionnés sont transférés vers le lecteur.

Avant de démarrer! ■ Branchez le lecteur sur l'ordinateur.
■ Media Studio doit être installé sur l'ordinateur.
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Utilisation du lecteur en tant
que disque amovible

Avant de démarrer ! ■ Branchez le lecteur sur l'ordinateur.

1 Ouvrez les fichiers/dossiers à transférer à
partir de l'ordinateur.

2 Ouvrez <My Computer> (Poste de travail)
➝ <Removable Disk> (Disque amovible)
depuis le bureau.

3 Sélectionnez les fichiers/dossiers que vous
souhaitez transférer depuis votre ordinateur
et faites un cliquer-glisser vers le dossier de
votre choix dans <Removable Disk> (Disque
amovible).
■ Les dossiers ou fichiers sélectionnés sont transférés

vers le lecteur.

■   Qu’est-ce que DRM ?

La technologie et le service DRM (Gestion des droits numériques) permettent d’éviter l'utilisation illégale de
données numériques et de protéger les détenteurs de droits d'auteur. Les fichiers DRM sont des fichiers
musicaux chargés pour lesquels s'applique la technologie de protection concernant les copies illégales de
fichiers musicaux MP3 obtenus de façon légale.

Vous pouvez utiliser le lecteur comme
appareil de stockage de données
amovible.

■   Le message de transfert du fichier apparaît durant son transfert. Débrancher le câble USB tant que le
message est affiché peut entraîner un dysfonctionnement de l'appareil.

■   L'ordre dans lequel les fichiers musicaux sont affichés dans l’explorateur Windows peut être différent de
l'ordre de lecture de l'appareil.

■   Si vous transférez un fichier DRM (fichier chargé) vers le disque amovible, le fichier ne sera pas lu.

ATTENTION
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Débrancher l'appareil de
l'ordinateur

Suivez les étapes ci-dessous pour éviter 
d'endommager le lecteur et les données au
moment du débranchement.

1 Positionnez le curseur de la souris sur
l'icône       située sur la barre des 
tâches en bas à droite du bureau et
cliquez sur le bouton gauche de la
souris.

2 Cliquez sur le message <Safely remove
USB Mass Storage Device Drive>
(Retirer en toute sécurité le lecteur USB
grande capacité).

3 Débranchez le lecteur de l'ordinateur.

■   Ne débranchez pas le lecteur de l'ordinateur durant le transfert du fichier. Les données ou le
lecteur risqueraient d’être endommagés.

■   Vous ne pouvez pas retirer le lecteur pendant que des fichiers contenus dans le lecteur sont lus
sur l'ordinateur. Veuillez réessayer une fois la lecture terminée.

ATTENTION

1

2
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Ecouter de la musique
Ecouter de la musique

Avant de démarrer! Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.

1 Appuyez longuement sur le bouton [ ] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner

<Music> (Musique), puis appuyez sur le bouton

[ ].

■ Le menu Music (Musique) apparaît.

Menu Music (Musique)
■   <Now Playing> (En lecture) : permet d'afficher le titre en

cours.
■   <File Browser> (Dossier Navigateur) : vous pouvez rechercher

un fichier musical.
■   <Playlists> (Listes de lecture) : lecture par liste

REMARQUE

■   Les fichiers musicaux compatibles avec le lecteur sont aux formats MP3, WMA et Ogg.
■   Les fichiers MP1 ou MP2 possédant uniquement une extension modifiée vers MP3 peuvent ne pas être lus.

3 Appuyez sur le bouton [ ] pour sélectionner

<File Browser> (Dossier Navigateur), puis

appuyez sur le bouton [ ].

1

2,3

Music
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4 Tap [ ] to select <MUSIC> folder, and then

tap [ ].
■   The music files for the selected folder will appear.

5 Appuyez sur le bouton [ ] pour 
sélectionner un fichier musical, puis appuyez
sur le bouton [ ].
■   La lecture de la musique démarre.

NOTE

■   Si vous sélectionnez le dossier <PICTURES> (IMAGES) ou <TEXT> (TEXTE) dans <File Browser>
(Dossier Navigateur), seuls les fichiers musicaux transférés dans le dossier <PICTURES> (IMAGES)
ou <TEXT> (TEXTE) s’affichent.

4,5

File Browser

MUSIC

PICTURES

PLAYLIST

TEXT
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Ecouter de la musique (suite)
Ecouter de la musique

Mode Pause (Pause)

1 Appuyez sur le bouton [ ] en cours de lecture.

■  La lecture de la musique est interrompue.

2 Appuyez de nouveau sur le bouton [ ].

■  La lecture reprend à l’endroit où vous l'avez suspendue.

REMARQUE

■   L’appareil s'éteint automatiquement lorsque aucun des boutons n'est actionné pendant une durée
prédéfinie (par défaut : 1 minute) en mode Pause (Pause).  √Page 46

Pour effectuer une recherche à l'intérieur d'une plage

1 Appuyez longuement sur le bouton[ ] en cours de lecture de la piste 
sélectionnée.

■  Ces boutons permettent d'effectuer la recherche vers le début ou la fin de la plage.

2 Relâchez le bouton dès que vous souhaitez reprendre la lecture.
■  La lecture commence dès que vous relâchez le bouton.
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Lecture de la plage en cours à partir du début.

Appuyez sur le bouton [ ] après 3 secondes de lecture.

■  La plage en cours est lue à partir du début.

Lecture de la plage précédente/suivante

Appuyez sur le bouton [ ] avant 3 secondes de lecture.

■  La lecture de la plage précédente démarre.

Appuyez sur le bouton [ ].

■  La lecture de la plage suivante démarre.

ATTENTION

■   Pendant la lecture de fichiers VBR, la piste précédente peut ne pas être lue même si vous appuyez
sur le bouton [ ] au cours des 3 premières secondes de lecture.
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Créer une liste de lecture avec Media Studio de Samsung
Ecouter de la musique

1 Cliquez sur le bouton <My Album> (Mon album) au haut de Media Studio.
■   La fenêtre <My Album> (Mon album) apparaît.

Une Liste de lecture est une liste de vos pièces musicales préférées.

2 Cliquez sur le bouton <New Album> (Nouvel album) au bas de l’écran.
■   La fenêtre Creation (Création) apparaît.

3 Tapez le titre de l’album et cliquez sur <OK>.
■   Un nouvel album (liste de lecture) est créé et enregistré dans la section My Album (Mon album)

de Media Studio.

1

2

3
3
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Transfert de fichiers musicaux sur une liste de lecture

Exporter une liste de lecture avec Media Studio

1 Cliquez sur le bouton <My PC> (Mon ordinateur)
au haut de Media Studio.
■   La fenêtre <My PC> (Mon ordinateur) apparaît. 

2 Cliquez sur le bouton <My Album> (Mon
album) dans le coin droit de la fenêtre.
■   La fenêtre Album (Album) apparaît.

3 Cliquez deux fois sur l’album souhaité dans la
fenêtre de droite.

4 Sélectionnez les fichiers que vous souhaitez 
transférer dans la fenêtre <My PC> (Mon ordinateur).

1 Cliquez sur le bouton <My Album> (Mon album)
au haut de Media Studio.
■   La fenêtre <My Album> (Mon album) apparaît.

2 Cliquez sur le bouton <Portable> (Portable)
dans le coin droit de la fenêtre.
■   La fenêtre <Portable> (Portable) apparaît.

3 Sélectionnez l’album souhaité sur la liste 
<My Album> (Mon album).

4 Cliquez sur l’icône .
■   L’album sélectionné est transféré sur le lecteur et

enregistré dans <Music> (Musique) ➝ <Playlists>
(Listes de lecture).

5 Cliquez sur l’icône .
■   Les fichiers sélectionnés sont ajoutés à l’album (liste

de lecture).

1

1

2

2

4

3
4

5
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Pour lire une liste de lecture
Ecouter de la musique

Avant de démarrer! Reportez-vous aux pages 28 et 29 pour plus de détails sur la création et le trans-
fert de listes de lecture sur votre lecteur.

1 Appuyez longuement sur le bouton [ ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner <Music>

(Musique), puis appuyez sur le bouton [ ].

■ Le menu Music (Musique) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner <Playlists>

(Listes de lecture), puis appuyez sur le bouton [ ].

■  La/Les liste(s) de lecture s'affiche(nt).

■  Si une liste de lecture n’est pas trouvée, le message <No File> (Aucun
fichier) s’affiche à l’écran.

4 Appuyez sur le bouton [ ] pour sélectionner la listes de

lecture souhaitée, puis appuyez sur le bouton [ ].
■   Les fichiers musicaux enregistrés dans la liste de lecture sélectionnée a

pparaissent.

5 Appuyez sur le bouton [ ] pour sélectionner un fichier 

musical, puis appuyez sur le bouton [ ].
■   La lecture du fichier musical démarre.

Music

Now Playing

File Browser

Playlists
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Pour sélectionner un effet sonore

Pour sélectionner l’égaliseur graphique EQ

1 Appuyez sur le bouton [ ] en cours de lecture.
■  Le menu des options de musique apparaît.

Vous pouvez sélectionner des effets sonores variés ; ils vous permettent de
rehausser la musique que vous écoutez.

2 Appuyez sur le bouton [ ] pour sélectionner <Sound
Effect> (Effets Sonores), puis appuyez sur le bouton [ ].

■  Le menu des effets sonores apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner l’effet

sonore souhaité, puis appuyez sur le bouton [ ].

■  Vous pouvez sélectionner soit <Normal> (Normal) <Vocal> (Voix) <Bass Boost>
(Ampli. basses) <3D Sound> (Son 3D) ou <Concert Hall> (Salle concert).

1 Appuyez sur le bouton [ ] en cours de lecture.
■  Le menu des options de musique apparaît.

2 Appuyez sur le bouton [ ] pour sélectionner <Graphic
EQ> (EQ Graphique), puis appuyez sur le bouton [ ].

■  Le menu de l’égaliseur graphique apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner <On> (Activé)

ou <Off> (Désactivé), puis appuyez sur le bouton [ ].

■  <On> (Activé) : l’égaliseur graphique s’affiche à l’écran.
■  <Off> (Désactivé) : l’égaliseur graphique ne s’affiche pas à l’écran.

Utilisation du menu option de musique
Ecouter de la musique

Sound Effect

Graphic EQ

Play Mode

Normal

Sound Effect

Graphic EQ

Play Mode

Normal
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Pour sélectionner le Mode lecture

1 Appuyez sur le bouton [ ] en cours de lecture.
■  Le menu des options de musique apparaît.

2 Appuyez sur le bouton [ ] pour sélectionner <Play Mode>
(Mode lecture), puis appuyez sur le bouton [ ].
■  Le menu du Mode lecture apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner le mode

souhaité, puis appuyez sur le bouton [ ].

■  Vous pouvez sélectionner <Normal> (Normal), <Repeat Folder>, <Repeat
All> (Répéter tout), <Repeat One> (Répéter une fois), <Shuffle Folder>
(Dossier aléatoire), ou <Shuffle All> (Lecture aléatoire de la totalité).

Utilisation du menu option de musique (suite)
Ecouter de la musique

■  <Normal> (Normal) : lecture ponctuelle et dans l’ordre de toutes les pistes.
■  <Repeat Folder> (Répéter dossier) : permet de répéter le dossier en cours.
■  <Repeat All> (Répéter tout) : permet de répéter tous les fichiers.
■  <Repeat One> (Répéter une fois) : répétition ponctuelle d’un fichier.
■  <Shuffle Folder> (Dossier aléatoire) : permet de lire les fichiers du dossier

dans un ordre aléatoire.
■  <Shuffle All> (Lecture aléatoire de la totalité) : permet de lire les fichiers

dans un ordre aléatoire.

Sound Effect

Graphic EQ

Play Mode

Normal
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Ecouter la radio FM

Ecouter la radio FM

Avant de démarrer! Branchez les écouteurs, puis allumez le lecteur et vérifiez le bloc-piles.

1 Appuyez longuement sur le bouton [ ] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ ] pour 

sélectionner <FM Radio> (Radio FM), puis

appuyez sur le bouton [ ].

■  La réception de la radio FM est activée.

Appuyez sur le bouton [ ] lorsque vous écoutez
la radio FM.
■   Le son est désactivé.

■   Appuyez à nouveau sur le bouton [ ] pour réactiver le son.

Pour utiliser la fonction Mute (Muet)

■   Branchez toujours vos écouteurs au lecteur lorsque vous recherchez ou réglez les fréquences. 
Les écouteurs sont utilisés comme antennes de réception des ondes FMATTENTION

1

2

FM Radio
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Pour basculer vers le Mode présélection

Pour basculer vers le mode manuel

1 Appuyez sur le bouton [ ] en <Manual Mode> (Mode manuel).

2 Appuyez sur le bouton [ ] pour sélectionne <Go to Preset

Mode> (Aller au Mode Présél.), puis appuyez sur le bouton [ ].

■  <Preset Mode> (Mode présélection) s’affiche.

3 Appuyez sur le bouton [ ] pour sélectionner la fréquence
présélectionnée.

■  Dès que <Preset Mode> (Mode présélection) s’affiche, vous pouvez
sélectionner une fréquence radio et l’écouter.

1 Appuyez sur le bouton [ ] en <Preset Mode> (Mode
présélection).

2 Appuyez sur le bouton [ ] pour sélectionne <Go to Manual
Mode> (Aller au mode manuel), puis appuyez sur le bouton [ ].

■  <Manual Mode> (Mode manuel) s’affiche.

REMARQUE

■   Si aucune fréquence n’est présélectionnée, le message <Preset list does not exist.> (Liste présélection
inexistante) s’affiche et le lecteur ne bascule pas en <Preset Mode> (Mode présélection).

■   Si vous sélectionnez <Default Set> (Réglages par défaut), les listes des préréglages sont supprimées.
■   Si vous sélectionnez <Preset List> (Liste présélection) dans le menu des options FM, vous pouvez voir

les fréquences présélectionnées.
■   Reportez-vous aux pages 36 et 37 pour plus de détails concernant le préréglage.

Ecouter la radio FM (suite)
Ecouter la radio FM

Sélectionnez ce mode si vous souhaitez effectuer une recherche manuelle d’une
fréquence à la fois sur la bande FM.

Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.

Go to Manual ..

Delete Preset

Auto Preset

Preset List

FM Sensitivity

Preset Mode

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode
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Pour rechercher manuellement les fréquences

Pour rechercher automatiquement les fréquences

Appuyez longuement sur le bouton [ ] en mode
<Manual Mode> (Mode manuel).

■  La fréquence la plus proche du point où le bouton est relâché est
recherchée.

Appuyez sur le bouton [ ] en <Manual Mode> (Mode manuel).

■  Change de fréquence à chaque nouvelle pression du bouton.

Manual Mode

Manual Mode
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Pour régler automatiquement les fréquences

1 Appuyez sur le bouton [ ] en mode FM Radio.

2 Appuyez sur le bouton [ ] pour sélectionne <Auto Preset>

(Présélection auto.), puis appuyez sur le bouton [ ].

■  La fenêtre Auto Preset (Présélection auto.) s’ouvre.

3 Appuyez sur le bouton [ ] pour sélectionne <Yes> (Oui),

puis appuyez sur le bouton [ ].

■  Les fréquences sont présélectionnées automatiquement jusqu’à 30.

Réglage d'une fréquence
Ecouter la radio FM

Vous pouvez prérégler jusqu’à 30 fréquences
radio FM.

Pour annuler une opération pendant le réglage

Appuyez sur le bouton [ ] pour annuler la balayage automatique.

■   Le préréglage automatique est annulé et les fréquences réglées jusque-là sont enregistrées.

■   Pour régler à nouveau la fonction <Auto Preset> (Préréglage automatique) après la 
configuration du préréglage, les fréquences existantes sont toutes supprimées et vous pouvez
alors procéder à une opération de réinitialisation depuis le début.

REMARQUE

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode
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Pour régler manuellement les fréquences

Pour rechercher les fréquences en mode Preset (Prereglage)

1 Appuyez légèrement sur [ ] pour sélectionner la

fréquence souhaitée dans <Manual Mode> (Mode manuel).

2 Appuyez sur le bouton [ ].

3 Appuyez sur le bouton [ ] pour sélectionner <Add Preset>

(Ajouter présélection), puis appuyez sur le bouton [ ].
■   La fréquence sélectionnée s’ajoute sur la Liste présélection. Un maximum de

30 numéros présélectionnés s’ajoute sur la liste en classement séquentiel.

Appuyez sur le bouton [ ] en <Preset Mode> (Mode présélection).

■  Le numéro présélectionné est sélectionné ; vous pouvez alors écouter la
fréquence radio attribuée à ce numéro.

4 Pour définir un numéro préréglé pour les autres fréquences,
suivez les étapes 1 à 3 ci-dessus.

■   Si vous tentez d’ajouter une fréquence déjà existante sur la Liste présélections, <This preset already
exists.> (Cette présélection existe déjà) s’affiche et elle n’est pas ajoutée.

REMARQUE

■   Si vous souhaitez vérifier la Liste présélections en <Preset Mode> (Mode présélection), appuyez sur
le bouton [ ] pour sélectionner <Preset List> (Liste présélections) et appuyez sur le bouton [ ].REMARQUE

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode

Preset Mode



38

1 Appuyez sur le bouton [ ] en <Preset Mode> (Mode 
présélection).

2 Appuyez sur le bouton [ ] pour sélectionne <Delete

Preset> (Supprimer Présél.), puis appuyez sur le bouton [ ].

■  La fréquence présélectionnée s’affiche.

3 Appuyez sur le bouton [ ] pour sélectionner la fréquence

présélectionnée à supprimer, puis appuyez sur le bouton [ ].
■   La fenêtre de confirmation apparaît.

4 Appuyez sur le bouton [ ] pour sélectionner <Yes> (Oui),

puis appuyez sur le bouton [ ].

■ Le numéro présélectionné sélectionné est supprimé.

5 Pour sélectionner et supprimer des numéros présélectionnés,
suivez les étapes 1 à 4 ci-dessus.

Pour supprimer les préréglages
Ecouter la radio FM

89.1MHz

89.2MHz

89.3MHz

89.4MHz

Delete Preset
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Ecouter la radio FM

Réglage de la radio FM

Pour régler la Sensibilité FM

1 Appuyez sur le bouton [ ] en mode FM Radio.

2 Appuyez sur le bouton [ ] pour sélectionne <FM Sensitivity>

(Sensibilité FM), puis appuyez sur le bouton [ ].

■  Le menu FM Sensitivity (Sensibilité FM) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner la sensibilité,

puis appuyez sur le bouton [ ].
■   Vous pouvez choisir entre <High> (Elevée), <Middle> (Moyenne) ou

<Low> (Basse).

■   Plus la sensibilité est élevée, plus vous pouvez capter de fréquences.

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode
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1 Appuyez longuement sur le bouton [ ] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ ] pour 

sélectionner <Photo>, puis appuyez sur le

bouton [ ].

■ La liste de photos apparaît.                       

3 Appuyez sur le bouton [ ] pour

sélectionner le fichier photo souhaité, 

puis appuyez sur le bouton [ ].

■ Le fichier sélectionné apparaît.
■ L’affichage des images de grande taille nécessite

plus de temps.

1 Appuyez sur le bouton [ ] en mode de
visionnement de photo.
■  Le diaporama démarre.

2 Appuyez sur le bouton [ ] pour arrêter le
diaporama.

Affichage du diaporama

Appuyez sur le bouton [ ].
■  La photo précédente ou suivante s’affiche à l’écran.

Pour visionner la photo précédente/suivante

REMARQUE

■   Vous pouvez voir la
vignette d’information de la
photo sur la liste.
Les fichiers ne contenant
pas d’information affichent
plutôt       .

Affichage de l'image
Affichage de l'image

Avant de démarrer! Reportez-vous aux pages 20 et 21 pour le transfert des photos sur votre lecteur.

Vous pouvez visionner vos fichiers photo en 
diaporama.

1

2,3
1,2

Photo
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Pour ajouter une photo sur la liste des économiseurs d’écran

Pour écouter la musique en regardant vos photos

1 Sélectionnez un fichier photo que vous souhaitez ajouter sur la
liste des économiseurs d’écran.

2 Appuyez sur le bouton [ ] en regardant la photo.
■   Le menu des options de photos apparaît.

3 Appuyez sur le bouton [ ] pour sélectionne <Add to

Screen Saver> (Ajouter à écono. écran), puis appuyez sur le

bouton [ ].

■  Le fichier photo sélectionné est ajouté à la liste des économiseurs
d'écran.

1 Appuyez sur le bouton [ ] en regardant la photo.
■   Le menu des options de photos apparaît.

Vous pouvez écouter la dernière pièce musicale tout en regardant vos photos.

2 Appuyez sur le bouton [ ] pour sélectionner <Background

Music On> ou <Background Music Off>.

■  <Background Music On> (Musique d’atmosphère activée) : permet 
d’écouter la dernière pièce musicale tout en regardant vos photos.

■  <Background Music Off> (Musique d’atmosphère désactivée) : aucune
musique d’atmosphère en regardant une photo.

Utilisation du menu option de photo
Affichage de l'image

REMARQUE

■   Sélectionnez <Photo> (Photo) depuis <Settings> (Réglages) → <Display> → (Afficher) → <Screen Saver>

(Economiseur d’écran) et la photo sélectionnée s’affiche comme économiseur d’écran. √ page 45

■   Si vous sélectionnez <Default Set> (Réglages par défaut), l'économiseur d'écran est initialisé sur
<Analog Clock> (Horloge analogique).

Background Mu..

Add to Screen S..

Background Mu..

Add to Screen S..
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Afficher un texte

Afficher un texte Vous pouvez lire un roman ou consulter le scénario d'un reportage
ou d'un feuilleton tout en écoutant de la musique.

Avant de démarrer !
■   Reportez-vous aux pages 20 à 21 pour le transfert des fichiers texte sur le lecteur.
■   Allumez le lecteur et vérifiez l'état de la batterie.
■   Sélectionnez la langue de votre choix pour le texte dans <ID3 Tag> (Etiquette ID3). 

√ Page 48

1 Appuyez longuement sur le bouton [ ] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélection-

ner <Text> (Texte), puis appuyez sur le bouton

[ ].

3 Appuyez sur le bouton [ ] pour 

sélectionner Text (Texte), puis appuyez sur le

bouton [ ].

■ Le texte s'affiche à l'écran.

■   Cet appareil prend en charge les fichiers au format TXT en mode Text (Texte).
■   Vous pouvez continuer à écouter de la musique même lorsque vous sélectionnez l’option <Text>

(Texte).
REMARQUE

1

2,3

Text
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Utiliser le menu Text (Texte)
Afficher un texte

interview

interview

Ecouter de la musique pendant l’affichage de votre texte

1 Appuyez longuement sur le bouton [ ] pendant 
l’affichage du texte.

■   Le menu d'option Text (Texte) apparaît.

Vous pouvez écouter la dernière chanson lue pendant l’affichage de votre texte.

2 Appuyez légèrement sur [ ] pour sélectionner

<Background Music On> (Musique de fond activée) ou

<Background Music Off> (Musique de fond désactivée).

■   <Background Music On> (Musique de fond activée) : vous pouvez
écouter la dernière chanson lue pendant l’affichage de votre texte.

■   <Background Music Off> (Musique de fond désactivée) : aucune
musique de fond ne peut être lue pendant l’affichage d’un texte.

Réglage du type de visionneuse de texte

1 Appuyez longuement sur le bouton [ ] pendant 
l’affichage du texte.

■   Le menu d'option Text (Texte) apparaît.

2 Appuyez sur le bouton [ ] pour sélectionner <Text

Viewer Type> (Type de visionneuse de texte), puis appuyez

sur le bouton [ ].

■  Le menu Text Viewer Type (Type de visionneuse de texte) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner le type

de visionneuse de texte souhaité.

■  Vous pouvez choisir entre <Type 1> (Type 1), <Type 2> (Type 2) ou
<Type 3> (Type 3).

Background Mu

Text Viewer Ty..

Background M..

Text Viewer Typ

■   Vous pouvez également régler le type de visionneuse de texte en appuyant légèrement sur [ ]
en mode d’affichage de texte.REMARQUE
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Configuration de l'affichage Vous pouvez régler l’économiseur d’écran et
l'heure de mise hors tension de l'écran.

Réglages

1 Appuyez longuement sur le bouton [ ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner <Settings>

(Réglages), puis appuyez sur le bouton [ ].

■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner <Display>

(Afficheur), puis appuyez sur le bouton [ ].

■  Le menu Display (Afficheur) apparaît.

4 Utilisez les boutons [ ] et [ ] pour régler les fonctions
souhaitées.

Fonctions des boutons pour la configuration
■   Appuyez sur le bouton [ ] pour défiler sur la liste.

■   Appuyez sur le bouton [ ] pour sélectionner et confirmer vos réglages.

■   Appuyez sur le bouton [ ] pour revenir à l'écran précédent.

REMARQUE

Display

Time

Language

System

Settings

Settings
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■ <Screen Saver> (Economiseur d’écran) : permet d’utiliser une image comme économiseur
d’écran. Choisissez-en une depuis <Analog Clock> (Horloge analogique), <Anim. 1>, <Anim. 2>,
<Anim. 3>, et <Photo> puis réglez la période d’attente. <Photo> est celle que vous avez choisie
comme économiseur d’écran dans <Add to Screen Saver> (Ajouter à écono. écran). √ page 41
Vous pouvez choisir entre <15 sec>, <30 sec>, <1 min>, <3 min>, <5 min>, et <Off> (Désactivé).
Si aucun nombre n'est entré pour la sélection de la période, le système bascule l'image de 
l'économiseur d'écran.

■  <Display Off> (Afficheur désactivé) : si aucun nombre n'est entré pour la sélection de la 
période, l’écran s’éteint automatiquement. Vous pouvez choisir entre <15 sec>, <30 sec>, 
<1 min>, <3 min>, <5 min>, et <Always On> (Toujours activé).
Lorsque l'écran d'affichage s'éteint, appuyez légèrement sur n'importe quel bouton pour l'allumer
à nouveau.

Réglage de l’économiseur d’écran

1 Appuyez sur le bouton [ ] pour sélectionner <Screen Saver>

(Économiseur d'écran), puis appuyez sur le bouton [ ].

■  Le menu des économiseurs d’écran apparaît.

2 Appuyez sur le bouton [ ] pour sélectionner l’image 

d’économiseur d’écran souhaitée, puis appuyez sur le bouton [ ].

3 Appuyez sur le bouton [ ] pour sélectionner une période

d’attente, puis appuyez sur le bouton [ ].

■  La fenêtre de confirmation apparaît.

4 Appuyez sur le bouton [ ] pour sélectionner <Yes> (Oui),

puis appuyez sur le bouton [ ].

■  Les réglages de l’économiseur d’écran sont complétés.

Photo

15 sec

Screen Saver
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Réglage de l'heure Vous pouvez régler les fonctions Sleep Timer (Minuteur d'arrêt)
et Auto Power Off (Arrêt automatique) en plus de l'heure
actuelle.

Réglages

1 Appuyez longuement sur le bouton [ ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner <Settings>

(Réglages), puis appuyez sur le bouton [ ].

■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner <Time>

(Heure), puis appuyez sur le bouton [ ].

■  Le menu Time (Heure) apparaît.

4 Utilisez les boutons [ ] et [ ] pour régler les fonctions
souhaitées.

■  <Sleep Timer> (Minuteur de mise en veille) : permet d’éteindre 
automatiquement l’appareil après l’écoulement de la durée présélectionnée.
Sélectionnez soit <Off> (Désactivé), <15 min >, <30 min>, <60 min>, 
<90 min>, ou <120 min>.

■  <Auto Power Off> (Mise hors tension automatique) : permet d’éteindre
automatiquement l’appareil lorsque aucun bouton n'est actionné avant 
l’écoulement de la durée présélectionnée en mode Pause (Pause).
Sélectionnez soit <15 sec>, <30 sec>, <1 min>, <3 min>, ou <5 min>.

■  <Time Set> (Réglage heure) : permet de régler l'heure actuelle. 
√ Page 47
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Réglage de l'heure

1 Appuyez sur le bouton [ ] pour sélectionner <Time set>

(Réglage heure), puis appuyez sur le bouton [ ].

2 Appuyez légèrement sur [ ] pour accéder à <AM/PM, Hour,

Minute> (AM/PM, Heure, Minute) et utilisez [ ] pour régler

l'heure.

3 Appuyez sur le bouton le bouton [ ].

■  La fenêtre de confirmation apparaît.

4 Appuyez sur le bouton [ ] pour sélectionner <Yes> (Oui),

puis appuyez sur le bouton [ ].
■  Le réglage de l'heure est enregistré.

Hour         Min

PM 06          35

Time Set
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Configuration de la langue Vous pouvez régler la langue du menu et de 
l’étiquette ID3.

Réglages

1 Appuyez longuement sur le bouton [ ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner <Settings>

(Réglages), puis appuyez sur le bouton [ ].

■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner <Language>

(Langue), puis appuyez sur le bouton [ ].

4 Utilisez [ ] et [ ] pour sélectionner la langue du menu.

■  <Menu> : permet de régler la langue du menu. Choisissez entre

<English>, < >, <Français>, <Deutsch>, <Italiano>, < >,

< >, < >, <Español>, < >, <Magyar>,
<Nederlands>, <Polski>, <Português>, et  <Svenska>.

■   <ID3-Tag> (Etiquette ID3) : permet de définir la langue des informations
concernant la plage ou la langue souhaitée du texte. Options disponibles
:  <Afrikaans>, <Basque>, <Catalan>, <Chinese(S)>, <Chinese(T)>,
<Czech>, <Danish>, <Dutch>, <English>, <Finnish>, <French>,
<German>, <Hrvatski>, <Hungarian>, <Icelandic>, <Italian>,
<Japanese>, <Korean>, <Norwegian>, <Polish>, <Portuguese>,
<Romany>, <Russian>, <Slovak>, <Slovene>, <Spanish>, et <Swedish>.

■   Les langues prises en charge peuvent être modifiées ou ajoutées.

■   Qu'est-ce que l'étiquette ID3 ?
Il s'agit d'un élément attaché à un fichier MP3 contenant les informations relatives au fichier telles que le titre,
l'artiste, l'album, l'année, le genre et un champ commentaire.

REMARQUE
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Configuration du système Permet de régler les dernières options de
mémorisation et du bip sonore.

Réglages

1 Appuyez longuement sur le bouton [ ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ ] pour sélectionner <Settings>

(Réglages), puis appuyez sur le bouton [ ].

■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ ] pour sélectionner <System>

(Système), puis appuyez sur le bouton [ ].

■  Le menu System (Système) apparaît.

4 Utilisez les boutons [ ] et [ ] pour régler les fonctions
souhaitées.

■   Bande de fréquences par région
- Corée/Etats-Unis: recherchez des fréquences FM comprises entre 87,5 MHz et 108,0 MHz pour les    

lecteurs de 100 kHz.
- Japon : recherchez des fréquences FM comprises entre 76,0 MHz et 108 MHz pour les lecteurs de 100 kHz.
- Autres pays : recherchez des fréquences FM comprises entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

■   La région FM peut être supprimée ou modifiée en fonction de la région cible du lecteur.

■   Si vous modifiez la région FM, les fréquences radio préalablement enregistrées seront supprimées.

REMARQUE

■ <Resume> (Reprise) : permet de définir le point de reprise de la lecture après avoir terminé l'écoute de
la musique. Sélectionner <On> (Activé) reprend la lecture depuis le dernier point d’arrêt tandis que <Off>
(Désactivé) reprend la lecture depuis le début de la dernière écoute de la musique.

■  <Beep> (Bip sonore) : Permet aux boutons d'émettre un son lorsqu’ils sont activés. Options
disponibles : <On> (Activé) ou <Off> (Désactivé).

■ <Volume Limit> (Limite du volume sonore) : permet d’éviter les blessures aux oreilles en
réglant la limite du volume sonore lorsque vous utilisez les écouteurs. <On> (Activé) limite le
niveau du volume à 20 tandis que <Off> (Désactivé) le limite jusqu’à 30.

■ <FM Region> (Région FM) : permet de choisir votre région pour la radio FM. Sélectionnez
depuis <Korea/USA> (Corée/E.-U.), <Japan> (Japon) et <Other Countries> (Autres pays).
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Réglage par défaut

1 Appuyez sur le bouton [ ] pour sélectionner <Default Set>

(Réglages par défaut), puis appuyez sur le bouton [ ].

■  La fenêtre de confirmation apparaît.

2 Appuyez sur le bouton [ ] pour sélectionner <Yes> (Oui),

puis appuyez sur le bouton [ ].
■   <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.
■   <No> (Non) : permet d'annuler les réglages par défaut.

Configuration du système (suite)
Réglages

■   <Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut.

■ <About> (A propos de) : permet de consulter les informations relatives à la version du micrologiciel,
à la capacité de la mémoire et au numéro de fichier.

■ Firmware Version (Version de micrologiciel) : indique la version de micrologiciel courante.
■ Memory (Mémoire) : indique la capacité restante de mémoire. <Used> (Utilisée) indique la partie utilisée,
<Remain> (Restante) indique la capacité restante et <Total> (Totale) indique la capacité de mémoire
totale.

■ Fichiers : <Music> (Musique) indique le nombre de fichiers musicaux, <Photo> (Photo) le nombre de photos,
<Text> (Texte) le nombre de textes et <Total> (Total) le nombre total de fichiers.

■   A propos de la mémoire intégrée
La taille de la mémoire intégrée réelle disponible est légèrement inférieure à celle indiquée, car le
micrologiciel interne en utilise une partie.

REMARQUE
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Dépannage Si un dysfonctionnement survient, vérifiez les points suivants.
Si le problème persiste, contactez le centre de dépannage Samsung le plus proche.

L'appareil ne s'allume
pas.

Les boutons ne 
fonctionnent pas.

L'écran ne s'allume pas.

L'alimentation est coupée.

Problème Points de contrôle et dépannage

■  Vérifiez si l'interrupteur [HOLD √] est dirigé dans le sens de la flèche.
■  Vérifiez que vous avez appuyé sur le bouton adéquat, puis

essayez à nouveau. √ Page 11

■  Appuyez sur le trou de réinitialisation

■  Si vous sélectionnez <Display Off> (Affich. désactivé) depuis <Settings> (Réglages)
→ <Display> (Afficheur), l’écran ACL demeure éteint. Tapez sur n’importe quel 
bouton pour allumer l’écran ACL ou vérifiez les réglages de l’afficheur. √ page 45

■   Il se peut que les données affichées à l’écran ne soient pas 
visibles sous les rayons directs du soleil.

■  Vérifiez l’état du bloc-piles.
■   L'alimentation se coupe automatiquement lorsque la batterie est

entièrement déchargée. Rechargez la batterie.
■  Si <Auto Power Off> (Arrêt automatique) est sélectionné dans <Settings>

(Réglages) → <Time> (Heure), l'alimentation est coupée en mode Pause
(Pause). Allumez le lecteur.

La durée de vie de la
batterie diffère de celle
indiquée dans le
manuel.

■  La durée du bloc-piles peut varier en fonction du mode sonore et
des réglages de l’écran.

■  La durée de vie du bloc-piles peut être réduite si vous l'exposez à des
températures basses ou élevées pendant des périodes prolongées.

Dysfonctionnement du
programme.

La connexion à 
l'ordinateur est désactivée.

Vérifiez que la configuration requise de l’ordinateur a été 
correctement établie.

Appuyez sur le menu Démarrer de la barre d'outil de votre ordinateur
pour lancer la mise à jour Windows. Redémarrez votre ordinateur et
rebranchez l'appareil.  

■  L'appareil ne s'allume pas si la batterie est entièrement déchargée.
Rechargez la batterie et remettez l'appareil sous tension.

■  Appuyez sur le trou de réinitialisation.
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L'appareil est chaud.
Les phases de chargement peuvent générer de la chaleur. Cela
n'a aucune incidence sur la durée de vie de l'appareil ou sur son
fonctionnement.

La lecture est 
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des 
données manquent.

Affichage anormal de la
durée de lecture.

Problème Points de contrôle et dépannage

■  Vérifiez que le fichier disponible a bien été enregistré dans le lecteur.
■  Assurez-vous que le fichier musical n’est pas endommagé.
■  Vérifiez que la puissance de la batterie est suffisante.

■  Vérifiez que le câble USB est correctement branché.
Rebranchez-le au besoin.

■  Assurez-vous qu’il reste de l’espace disponible sur la mémoire.
■  Appuyez sur le trou de réinitialisation

Vérifiez que le câble USB n’a pas été débranché durant le transfert
du fichier ou des données. Si tel est le cas, les fichiers/données mais
également l’appareil risquent d’être endommagés. Vous devez faire
preuve d'une extrême prudence à cet égard car Samsung ne saurait
en aucun cas être tenu responsable de la perte des données. 

Vérifiez que le fichier est au format VBR (débit binaire variable).

Dépannage (suite)

Affichage anormal du nom
de fichier

Allez à <Settings> (Réglages) → <Language> (Langue) → <ID3
Tag> (Etiquette ID3) dans l'écran de menu et sélectionnez la
langue appropriée.
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Arborescence des menus Cette fonction vous permet de consulter 
rapidement la structure du menu.

Ecran de sélection du menu

»≠∏È º≥¡§Display

Music FM Radio Photo Settings

Screen saver

Display Off

Menu

ID3 Tag

Time

Sleep Timer

Auto Power Off

Time Set

Language System

Resume

Beep

Volume Limit

FM Region

Default Set

About
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Caractéristiques du produit

Nom du modèle

Alimentation

Alimentation de la batterie intégrée

Sortie des écouteurs

Bande de fréquences de la sortie

Signal du taux de bruit

Durée de lecture

Plage de températures de fonctionnement

Boitier

Poids

Dimensions (L x H x P)

Fréquence FM

Rapport signal FM

T.H.D. FM

Sensibilité FM utile

Fichier Compatibilité

YP-K3

3,7V (Lithium polymère rechargeable)

500mAh

Music : MPEG1/2/2.5 3 couches (8 kbps à 320 kbps, 22 kHz à 48
kHz), WMA(48kbps à 192kbps, 22kHz à 48kHz)

Image : JPEG (ISO/IEC 10918-1/Annexe F – Mode de 
fonctionnement séquentiel DCT)

20 mW (16 Ω)

20 Hz à 20 KHz

90 dB avec filtre passe bas 20 kHz (à partir de 1 KHz, 0 dB)

25 heures de musique (fondé sur MP3 à 128 kbps, niveau de volume 
à 15 en mode normal)

-5 à 35°C

Inoxydable, plastique

1.76 oz (50g)

1.73 X 3.78 X 0.27 inches (44 X 96 X 6.95 mm)

87,5~108,0MHz

55dB

1%

38dBµ

● Le contenu de ce manuel est susceptible d'être modifié en vue d’être amélioré sans
notification préalable.
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Licence

L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée à une
utilisation privée non commerciale par l’utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à un 
produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit. 
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions 
du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.



Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.

Comment contacter Samsung dans le monde

Country Customer Care Center Web Site

CANADA 1-800-SAMSUNG (7267864) www.samsung.com/ca
MEXICO 01-800-SAMSUNG (7267864) www.samsung.com/mx
U.S.A 1-800-SAMSUNG (7267864) www.samsung.com
ARGENTINE 0800-333-3733 www.samsung.com/ar
BRAZIL 0800-124-421 www.samsung.com/br
CHILE 800-726-7864(SAMSUNG) www.samsung.com/cl
COSTA RICA 0-800-507-7267 www.samsung.com/latin
ECUADOR 1-800-10-7267 www.samsung.com/latin
EL SALVADOR 800-6225 www.samsung.com/latin
GUATEMALA 1-800-299-0013 www.samsung.com/latin
JAMAICA 1-800-234-7267 www.samsung.com/latin
PANAMA 800-7267 www.samsung.com/latin
PUERTO RICO 1-800-682-3180 www.samsung.com/latin
REP. DOMINICA 1-800-751-2676 www.samsung.com/latin
TRINIDAD & TOBAGO 1-800-7267-864 www.samsung.com/latin
VENEZUELA 1-800-100-5303 www.samsung.com/latin
BELGIUM 02 201 2418 www.samsung.com/be
CZECH REPUBLIC 844 000 844 www.samsung.com/cz
DENMARK 38 322 887 www.samsung.com/dk
FINLAND 09 693 79 554 www.samsung.com/fi
FRANCE 08 25 08 65 65 ( 0,15/Min) www.samsung.fr
GERMANY 01805 - 121213 ( 0,14/Min) www.samsung.de



Country Customer Care Center Web Site

HUNGARY 06 40  985 985 www.samsung.com/hu
ITALIA 199 153 153 www.samsung.com/it
LUXEMBURG 02 261 03 710 www.samsung.lu
NETHERLANDS 0900 20 200 88 ( 0,10/Min) www.samsung.com/nl
NORWAY 231 627 22 www.samsung.com/no
POLAND 0 801 801 881 www.samsung.com/pl
PORTUGAL 80 8 200 128 www.samsung.com/pt
SLOVAKIA 0850 123 989 www.samsung.com/sk 
SPAIN 902 10 11 30 www.samsung.com/es
SWEDEN 08 585 367 87 www.samsung.com/se
U.K 0870 SAMSUNG (7267864) www.samsung.com/uk
REP. Ireland 0818 717 100 www.samsung.com/uk
RUSSIA 8-800-200-0400 www.samsung.ru
UKRAINE 8-800-502-0000 www.samsung.com/ur
AUSTRALIA 1300 362 603 www.samsung.com/au
CHINA 800-810-5858, 010-6475-1880 www.samsung.com.cn 
HONG KONG 3698 - 4698 www.samsung.com/hk
INDIA 3030 82821600 1100 11 www.samsung.com/in
INDONESIA 0800-112-8888 www.samsung.com/id
JAPAN 0120-327-527 www.samsung.com/jp
MALAYSIA 1800-88-9999 www.samsung.com/my
PHILIPPINES 1800-10-SAMSUNG (7267864) www.samsung.com/ph
SINGAPORE 1800-SAMSUNG (7267864) www.samsung.com/sg
THAILAND 1800-29-3232 / 02-689-3232 www.samsung.com/th
TAIWAN 0800-329-999 www.samsung.com/tw
VIETNAM 1 800 588 889 www.samsung.com/vn
SOUTH AFRICA 0860 7267864 (SAMSUNG) www.samsung.com/za
U.A.E 800SAMSUNG (7267864) www.samsung.com/mea
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